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Introduction

FCC (USA)-INFORMATION

NOTE: This equipment has been tested and found to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable
protection against harmful interference in a residential installation. This equipment generates,
uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instructions, may cause harmful interference to radio communications. However, there is no
guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the
equipment off and on, the user is encouraged to try to correct the interference by one or more of
the following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to which the receiver is
connected.

e Consult the dealer or an experienced radio/TV technician for help.

USER-INSTALLER CAUTION: Your authority to operate this FCC verified equipment could
be voided if you make changes or modifications not expressly approved by the party.




Thank you for purchasing the IK-WF51R Network Camera. Before using the camera, read this
User's Manual carefully to ensure correct usage. After reading this User's Manual, save it for
future reference.

The design, specifications, software, and User's Manual contents are subject to change without
prior notice.

Terms

I The term "OS" is used in this manual to indicate operating systems compatible with this
product.

-- Microsoft® Windows® 7 Professional Edition

ANOTE _

e The performance of the network camera may vary depending on the network environment.
e When using multiple network cameras, the appropriate network switch and PC are required.
e This camera does not support MAC-PC.




Important Safeguards

1. Read Instructions

Read all the safety and operating instructions before operating the product.
2. Retain Instructions

Retain the safety instructions and user's manual for future reference.
3. Warnings

Comply with all warnings on the product and in the user's manual.
4. Follow Instructions

Follow all operating and use instructions.
5. Cleaning

Disconnect this camera from the power supply before cleaning.
6. Attachments

Do not use attachments not recommended by the camera manufacturer as they may pose
safety risks.

7. Accessories

Do not place this camera on an unstable cart, stand, tripod, bracket or table. The camera
may fall, causing serious injury to a person, or serious damage to the product. Use only with
stand, tripod,bracket,or table recommended by the manufacturer, or sold with the camera.
Any mounting of the product should follow the manufacturer's instructions, and should use a
mounting accessory recommended by the manufacturer.

8. Ventilation

This camera should never be placed near or over a radiator or heat register. If this product
is placed in a built-in installation, verify that there is proper ventilation so that the camera
temperature operates within the recommended temperature range.

9. Power Sources

This camera should be operated only from the type of power source indicated on the
information label. If you are not sure of the type of power supply at your location, consult your
product dealer.

10. Power-Cord Protection

Power cords should be routed so that they are not likely to be walked on or pinched by items
placed upon or against them. Pay particular attention to cords at plugs, screws and the point
where they exit the product.

11. Installation

Install this camera on a secure part of the ceiling or wall. If installed on an unsecured location,
the camera could fall causing injury and damage.




12. Lightning
For additional protection on this camera during a lightning storm, or when it is left unattended

and unused for long periods of time, unplug it from the wall outlet and disconnect the power
supply and cable system. This will prevent damage to the camera due to lightning and power-
line surges. If lightning occurs, do not touch the unit or any connected cables in order to avoid
electric shock.

13. Overloading
Do not overload the power supply or extension cords as this can result in a risk of fire or

electric shock.

14. Object and Liquid Entry
Never push objects of any kind into this camera through openings as they may touch
dangerous electrical points or short-out parts that could result in a fire or electrical shock.
Never intentionally spill liquid of any kind on the camera.

15. Servicing
Do not attempt to service this camera yourself as opening or removing covers may expose

you to dangerous electrical or other hazards. Refer all servicing to qualified service personnel.

16. Damage Requiring Service
Disconnect this camera from the power supply and refer servicing to qualified service

personnel under the following conditions.

a. When the power-supply cord or plug is damaged.

b. If liquid has been spilled, or objects have fallen into the camera.
c. If the camera has been submerged in water.

d. If the camera does not operate normally by following the operating instructions in the user's
manual. Adjust only those controls that are covered by the user's manual as an improper
adjustment of other controls may result in damage and will often require extensive work by a
qualified technician to restore the camera to its normal operation.

e. If the camera has been dropped or the cabinet has been damaged.

f. When the camera exhibiting a distinct change in performance which indicates a need for
service.

g. Other trouble.
17. Replacement Parts

When replacing parts, be sure the service technician uses parts specified by the manufacturer
or have the same characteristics as the original part. Unauthorized substitutions may result in
fire, electric shock or other hazards.

18. Safety Check

Upon completion of any service or repairs to this camera, ask the service technician to
perform safety checks to determine that the camera is in proper operating condition.




Important Safeguards (Cont.)

CAUTION TO REDUCE THE RISK OF ELECTRIC SHOCK.

DO NOT REMOVE COVER. NO USER SERVICEABLE PARTS INSIDE. REFER
SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within an equilateral triangle,
is intended to alert the user to the presence of uninsulated "dangerous
voltage" within the product's enclosure that may be of sufficient
magnitude to constitute a risk of electric shock to persons.

the user to the presence of important operating and maintenance

g The exclamation point within an equilateral triangle is intended to alert
(servicing) instructions in the literature accompanying the appliance.

WARNING:

TO REDUCE THE RISK OF FIRE OR
ELECTRIC SHOCK, DO NOT EXPOSE THIS
APPLIANCE TO RAIN OR MOISTURE.

FIELD INSTALLATION MARKING:

WORDED: “THIS INSTALLATION SHOULD BE MADE BY A QUALIFIED SERVICE
PERSON AND SHOULD CONFORM TO ALL LOCAL CODES.”

This product is intended to be supplied by a Listed Power Adapter with LPS, rated PoE 42.5-
57Vdc, 0.55-0.41A: 12V DC, 2.1A.

The product is not likely to require connection to an Ethernet network with outside plant
routing, including campus environment; and the installation instructions clearly state that the
ITE is to be connected only to PoE networks without routing to the outside plant.

Ce produit est congu pour étre alimenté par un adaptateur secteur Listed avec LPS, classé
PoE 42.5-57Vdc, 0.55-0.41A: 12V DC, 2.1A.

Le produit ne est pas susceptible de nécessiter une connexion a un réseau Ethernet avec
I'extérieur routage des plantes, y compris I'environnement de campus; et les instructions
d'installation clairement que I' état ITE doit étre raccordé uniguement aux réseaux PoE sans
routage vers le installations extérieures.




Notes on Use and Installation

® Do not aim the camera at the sun

Never aim the camera at the sun even with the camera power off.

® Do not shoot intense light

Intense light such as a spotlight may cause a bloom or smear. A vertical stripe may appear on
the screen. However, this is not a malfunction.

® Treat the camera with care

Dropping or subjecting the camera to intense vibration may cause it to malfunction.
® Never touch internal parts

Do not touch the internal parts of the camera other than the parts specified.
® Do not submerge in water

The camera has some protection to water (see IP rating), and can be used indoors or
outdoors. If the camera was submerged in water, turn off the power and contact your dealer.

® Keep the camera installation away from video noise

If cables are wired near electric lighting wires or a TV set, noise may appear in images. In this
event relocate cables or reinstall equipment.

® Check the ambient temperature and humidity

Avoid using the camera where the temperature is hotter or colder than the specified operating
range. Doing so could affect the internal parts or cause the image quality to deteriorate.
Special care is required to use the camera at high temperature and humidity.

® Should you notice any trouble

If any trouble occurs while you are using the camera, turn off the power and contact your
dealer. If you continue to use the camera when there is something wrong with it, the trouble
may get worse and an unpredictable problem may occur.




Precautions for Use

Disclaimer

We disclaim any responsibility and shall be held harmless for any damages or losses

incurred by the user in any of the following cases:

1. Fire, earthquake or any other act of God; acts by third parties; misuse by the user, whether
intentional or accidental; use under extreme operating conditions.

2. Malfunction or non-function resulting in indirect, additional or consequential damages,
including but not limited to loss of expected income and suspension of business activities.

3. Incorrect use not in compliance with instructions in this user's manual.

4. Malfunctions resulting from misconnection to other equipment.

5. Repairs or modifications made by the user or caused to be made by the user and carried out
by an unauthorized third party.

Notwithstanding the foregoing, Toshiba's liabilities shall not, in any circumstances, exceed the
purchase price of the product.

Copyright and Right of Portrait

There may be a conflict with the Copyright Law and other laws when a customer uses, displays,
distributes, or exhibits an image picked up by the camera without permission from the copyright
holder. Please also note that transfer of an image or file covered by copyright is restricted to use
within the scope permitted by the Copyright Law.

Protection of Personal Information
Images taken by the camera that reveal the likeness of an individual person may be considered
personal information. To disclose, exhibit or transmit those images over the internet or otherwise,
consent of the person may be required.

Usage Limitation

The product is not designed for any "critical applications." "Critical applications" means life
support systems, exhaust or smoke extraction applications, medical applications, commercial
aviation, mass transit applications, military applications, homeland security applications, nuclear
facilities or systems or any other applications where product failure could lead to injury to
persons or loss of life or catastrophic property damage.

Accordingly, Toshiba disclaims any and all liability arising out of the use of the product in any
critical applications.




Package Contents

® |[K-WF51R

® CD-ROM

® Warranty Card

® Mounting Plate /
Torx driver

® Power & I/O cable

® Alignment Sticker

Oe

For Mounting Plate For Camera Base

® Quick Start Guide and Important
Safeguards

TOSHIBA
Leading Innovation 5>
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® Gasket / Sillica Gel and tape /
Rubber Washer / Screws and Anchors




Physical Description

/7 - f _ I

» Cover Screws

\ » Dome Cover
\ @ / » Clear Cover

Built-in Microphone <—\J_//\

IR illuminator Cover




CAMERA MAIN UNIT
® |Inner View

Lens
A

Contacts (A)

Header (J7)

> ‘\‘\. ~ // \3-5 AN \ N 7 :’;: ,/'ﬂ‘/”” \ - 4%6 ‘%;;
J ,»‘I” ! \‘_’:\ \—/l.l y /7! J ) \\'%.)’:‘
== o Contacts for IR units (B)
Header (J6) OTE
Align (B) to (A) when attaching
Ethernet 10/100 RJ45 Socket the dome cover

Gasket for RJ45 LAN Cable

# NOTE

White gasket is for
transportation. Don't use it
” | in installation.

Reset
Button

Status LEDs

MicroSD/SDHC/SDXC Card Slot




Physical Description

General I/0 Terminal Block

This Network Camera provides a general 1/0 terminal block which is used to connect
external input / output devices.

# NOTE

e 3.3V DC is outputted from the terminal when connected to a power supply.

The diagrams below apply when "Digital Input” is used for an alarm input.




Status LED

The LED indicates the status of the Network Camera.

ltem  LED Status Description
1 Steady Red Power on and system booting
Red LED off Powered off

2 Steady Red + blinking Green every 1 sec. (Green LED on for|Network heartbeat
1 sec and off for another)
Steady Red + Green LED off Network disconnected
3 Blinking Red every 0.15 sec. + Blinking Green every 1 sec.|Upgrading firmware
(Red LED on for 0.15 sec. and Green LED on for 1 sec. and
off for another)

4 Blinking Red every 0.15 sec. + blinking Green every 0.15 sec |Restoring defaults

Hardware Reset

The reset button is used to reset the system or restore the factory default settings. Occasionally
resetting the system can return the camera to normal operation. If the system problems remain
after resetting, restore the factory settings and install again.

Reset:Hold for about 3 seconds and release the recessed reset button with a paper clip or small
object. Wait for the Network Camera to reboot.

Restore:Press and hold the recessed reset button until the status LED rapidly blinks. It takes

about 10 seconds. Note that all settings will be restored to factory default. Upon successful
restore, the status LED will blink during normal operation.

A Restoring the factory defaults will erase any previous settings.




SD/SDHC/SDXC Card and Capacity

This network camera is compliant with Micro SD/SDHC/SDXC 64GB and other preceding
standard Micro SD cards for local storage.

# NOTE

e There is a limit to the number of rewrites that is possible with the SD memory card. Replacing
the SD memory card when performing periodic maintenance of the camera is recommended.

e Do not use 512MB and below SD memory cards.

e The Camera system reserves approximately 60MB in SD memory cards. Any images are not
recordable on this space.

e Carefully read the User’s guide, precautions on use, and any other information supplied with a
purchased memory card.

e An SD memory card can be used for repeated storage. The lifespan (number of rewrites
possible) of an SD memory card is greatly affected by the capacity of the SD memory card.

e Do not use a memory card containing the data recorded by another device with the camera as
this may result in the camera not functioning correctly.

e Do not modify, overwrite the data, or change the folder name of an SD memory card. It may
result in the camera not to function correctly.

OFF the event status in Event window on page 108 and the recording status in

ﬂ If you Power-OFF or remove the SD memory card from camera, you have to turn
Recording window on page 121 preliminarily.




Installation

Hardware Installation

Please verify that your product package contains all the accessories listed in the Package
Contents listed on page 11. Depending on the user’s application, an Ethernet cable may
be needed. The Ethernet cable should meet the specs of UTP Category 5 or higher.

Hardware Installation is shown in the Quick Start Guide(QSG). Please refer to page 13 of the
QSG.

Network Deployment

In this user’s manual, “User” refers to whoever has access to the Network Camera,
and “Administrator” refers to the person who can configure the Network Camera and
grant user access to the camera.

Network Deployment is shown in the Quick Start Guide(QSG). Please refer to page 18 of the
QSG.

Setting up the Network Camera over the Internet

There are several ways to set up the Network Camera over the Internet. The first way is to set
up the Network Camera behind a router. The second way is to utilize a static IP. The third way is
to use PPPoE.

Internet connection via a router

Before setting up the Network Camera over the Internet, make sure you have a router and follow
the steps below.

1. Connect your Network Camera behind a router, the Internet environment is illustrated below.
Regarding how to obtain your IP address, please refer to Software Installation on page 19 for
details.

/ IP address : 192.168.0.3
WAN (Wide Area Network )

R IP addi : from ISP, Subnet mask : 255.255.255.0
outer 1P address ¢ from 19 Default router : 192.168.0.1

Internet

LAN (Local Area Network)
Router IP address : 192.168.0.1

This client PC sets up
Cable or DSL Modem M/ a camera and a router.
N -

Example Network Environment IP address : 192.168.0.2
Subnet mask : 255.255.255.0

Default router : 192.168.0.1




2. In this case, if the Local Area Network (LAN) IP address of your Network Camera is
192.168.0.3, please forward the following ports for the Network Camera on the router.

m HTTP port: default is 80

m RTSP port: default is 554

m RTP port for audio: default is 5558
m RTCP port for audio: default is 5559
m RTP port for video: default is 5556
m RTCP port for video: default is 5557

If you have changed the port numbers on the Network page, please open the ports accordingly

on your router. For information on how to forward ports on the router, please refer to your

router’s user’s manual.

3. Determine the public IP address of your router provided by your ISP (Internet Service
Provider). Use the public IP and the secondary HTTP port to access the Network Camera
from the Internet. Please refer to Network Type on page 60 for details.

Internet connection with static IP

Choose this connection type if you are required to use a static IP for the Network Camera.
Please refer to LAN on page 60 for details.

Intern nnection via PPPoE (Point-to-Point over Ethern

Choose this connection type if you are connected to the Internet via a DSL Line. Please refer to
PPPoE on page 61 for details.




Software Installation

Installation Wizard (IW), a free-bundled software packaged in the product CD, helps to set up
your Network Camera in a LAN.

1. Install the IW under the Software Utility directory from the software CD.
Double click the IW shortcut on your desktop to launch the program.

Installation
Wizard

2. The program will analyze your network environment. After your network environment is
analyzed, please click [Next] to continue the program.

.Q Installation Wizard - Network Type

|nsfallatian X(izard

Your network environment was analyzed as below.

No connection to Internet

Intemet Sy : ;
Cable/sL | - 1P Camera
modem

Router |—

PC

3. The program will search for Network Cameras on the same LAN.

4. After searching, the main installer window will pop up. Click on the MAC and model name
which matches the MAC of the camera.

Q Installation Wizard E
Device Sel.ection Insta”ation WEzard
Select a device to setup or upgrade L 3

To s H I BA MAC IF Address IModel

NETWORK CAMERA MODEL No. IK-WF51R 00-02-D1-71-42-70 168,254,099 IK-WR12A

e EEN (oorrien |
- Refresh

This device complies with Part 15 of the FCC Rules. Devices 0002D1714270
Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and [H us v —

(2) this device must accept any interference received,
including interference that may cause undesired operation. LISTED

I.T.E.
CAN ICES-3 B/ NMB-3 B 38KG

, MADE IN TAWAN
TOSHIBA CORPORATION FABRIQUE EN FORYGSP”

SIN:__A1510XXXX A/
MAC: 0002D1XXXXXX
AR A A

Please check the MAC and model name in the
product label of your device first.
Then, you can start w link W yow device and

show the main screen by double clicking the
N OT E item in the ahove selection list.

If you are not able to find your device in the

N . . . ahove selection list, please make sure all ‘—'m |
[ ] Th |S Softwa re |S proprletary Cl |ent cables are l!:ltmperls;r Ennnecled to your device  You can find the product label in
and then click on the "Refresh Devices” the rear/bottom part of your
software for TOSHIBA Network buton. device.

Camera.




Ready to Use

1. Access the Network Camera on the LAN.
2. Retrieve live video through a web browser.




Accessing the Network Camera

This chapter explains how to access the Network Camera through web browsers, RTSP players
and 3GPP-compatible mobile devices.

Using Web Browsers

Use Installation Wizard to access the Network Cameras on the LAN.

If your network environment is not a LAN, follow these steps to access the Network Camera:

1. Launch your web browser (Microsoft® Internet Explorer).

2. Enter the IP address of the Network Camera in the address field. Press Enter.

3. The live video will be displayed in your web browser.

4. If it is the first time installing the network camera, an information bar will pop up. Follow the
instructions to install the required plug-in on your computer.

A IMPORTANT

» By default, the Network Camera is not password-protected. To prevent unauthorized access,
it is highly recommended to set a password for the Network Camera.
For more information about how to enable password protection, please refer to Security on
page 49.




» If you see a dialog box indicating that your security settings prohibit running ActiveX®
Controls, please enable the ActiveX® Controls for your browser.

1. Choose Tools > Internet Options > Security > Custom Level.

-

2. Look for Download signed ActiveX® controls; select Enable or Prompt. Click OK.

3. Refresh your web browser, then install the Active X® control. Follow the instructions to
complete installation.

A NOTE

e Currently the Network Camera utilizes 32-bit Active X® plug-in. You CAN NOT open a
Configuration/view session with the camera using a 64-bit IE browser.




Using RTSP Players

To view the H.264/MPEG-4 streaming media using RTSP players, you can use players that
support RTSP streaming.

1. Launch the RTSP player.

2. Choose File > Open URL. A URL dialog box will pop up.

3. The address format is rtsp://<ip address>:<rtsp port>/<RTSP streaming access name for
stream1, stream?2 or stream3>

As most ISPs and players only allow RTSP streaming through port number 554, please set the
RTSP port to 554. For more information, please refer to RTSP Streaming on page 69.
For example:

rtsp:/ /XXX XXX XXX XxX:554/live2.sdp

4. The live video will be displayed in your player.
For more information on how to configure the RTSP access name, please refer to RTSP

Streaming on page 69 for details.




Using 3GPP-compatible Mobile Devices

To view the streaming media through 3GPP-compatible mobile devices, make sure the Network
Camera can be accessed over the Internet. For more information on how to set up the Network
Camera over the Internet, please refer to Setup the Network Camera over the Internet on page
17.

To utilize this feature, please check the following settings on your Network Camera:

1. Because most players on 3GPP mobile phones do not support RTSP authentication, make
sure the authentication mode of RTSP streaming is set to disable.
For more information, please refer to RTSP Streaming on page 69.

2. As the bandwidth on 3G networks is limited, you will not be able to use a large video size.
Please set the video and audio streaming parameters as listed below.

Video Mode T H.264
Frame size T 176 x 144
Maximum frame rate ~~ 5fps
Intra frame period 1S

Video quality (Constant bit rate) ~ 40kbps
Audio type (GSM-AMR) " 12.2kbps

3. As most ISPs and players only allow RTSP streaming through port number 554, please set
the RTSP port to 554. For more information, please refer to RTSP Streaming on page 69.

4. Launch the player on the 3GPP-compatible mobile devices.

5. Type the following URL commands into the player.
The address format is rtsp://<public ip address of your camera>:<rtsp port>/<RTSP streaming
access name for stream # with small frame size and frame rate>.
For example:

rtsp:/ /xx . xox.xox.xxx:554/live2.sdp




Main Page

This chapter explains the screen elements on the main page. It is composed of the following
sections: TOSHIBA Logo, Host Name, Camera Control Area, Configuration Area, and Live Video
Window.

TOSHIBA logo
Resize Buttons

l Host name <«=——

Camera Control

Area ~—]

Configuration
Area -

TOSHIBA Logo
Click this logo to visit the TOSHIBA website.

Host Name
The host name can be customized to fit your needs. For more information, please refer to System > General
Settings on page 38.

Camera Control Area

Display mode: This is a configuration menu exclusively designed for Panoramic cameras. Due to the
fisheye lens’ wide coverage of hemispheric and panoramic views and to manipulate the details within,
the following display modes are provided:

10 - One Original hemispheric view.

1P - One Panoramic view

1R - One Regional view

1P2R - One Panoramic and two Regional views (Wall mount)
2P - Two Panoramic views

1P3R - One Panoramic and three Regional views (Wall mount)
103R - One Original and three Regional views

4R - Four Regional views

4R PRO - Four Regional views interactively displayed when the field
of view changes in any of the views

108R - One Original and eight Regional views

* Most display modes are available in the Ceiling mount type.




A IMPORTANT:

The Local dewarp function is designed for use with 3rd-party software that did not implement the
dewarp plug-ins. A video stream can be dewarped on the camera into a regional or panoramic
view before being sent to the client side. However, since the video has already been dewarped
into a more viewable rectilinear view, you can not exert PTZ control or change the view angle on
the client computer.

When using the Local dewarp, you should configure the view angle of a regional view in the
PTZ > PTZ settings window.

Below are the appearances of the control panel when the Local dewarp function is enabled or
disabled. The PTZ panel and the Display mode menu disappear when a video stream is using
the Local dewarp function. See page 88 for more information.

Local dewarp (on camera) Dewarp by client-side plug-ins




10 (Original) Display mode: 10 View (Original View)

When mounted on a ceiling, the panoramic camera can
cover an approximately 50 m? surveillance area (hung

at a height of approximately 3 meters), while still keeping
details in videos with recognizable facial features of
people trafficking through the area.

)

175° Hemispheric

The 10 view is especially adequate for taking an over-
view glimpse of surveillance area with a ceiling mount
camera.

1P (Single Panoramic) Display mode:

With image correction firmware algorithms, the hemispheric image is transformed into a rectilinear stripe in the 1P display mode.
Viewers can use the PTZ panel or simply use mouse control to quickly move through the 360° panoramic view. (Mouse control

on the Panoramic view is available with the Ceiling mount type.)
Note that while the 1P view is apt for an overview, the Zoom infout function does not apply in this mode.

Swipe to scroll horizontally

(—

A IMPORTANT:

If the Local dewarp mode is selected for a video stream, the mouse control on the screen will
be disabled. For example, if stream #1 is configured into the 1R mode (see description on the
next page), its view angle will not be configurable using the mouse control.




1R (Single Regional) Display mode:

The 1R mode provides access to one image section within the hemisphere. You can zoom in or out (using the mouse wheel or
PTZ panel) or travel to other areas in the hemisphere using mouse clicks and swipes. A single click on a particular object can
bring the object to the center of your view window. Click and hold down the left mouse button, and you can swipe the view both
horizontally and vertically. Double click on a view window can bring to the center of hemisphere.

1R View (Single Regional View)

Zoom In Zoom Out

Zoom in/out
&
all-directional
navigation control

2P (Dual Panoramic View) Display mode:

Similar to 1P, the 2P display mode provides simultaneous access to both the left and right sections of a hemisphere. Both
panoramic views are corrected into a more viewable dewarped image. Viewers can use a mouse click and swipe to quickly
scroll horizontally through the surveillance area.

* Note that the dividing line falls approximately on the center of the TOSHIBA logo.

2P View (Panoramic View) Converted to rectilinear view (Dewarp)

nght heml n

Left hemi




103R (One Original & Three Regional) Display mode:

The 103R mode provides access to multiple live view sections within the hemisphere and the reference to their relative
positions on an Original circular view. The FOV indicators (#1 ~ #3) interact with your current operation as you may zoom in/out
or move the live view window to a different place.

You can zoom in or out or travel to other areas within the hemisphere using identical methods as previously described in the 1R
mode.

You can also change the locations of Regional views by dragging the FOV indicators on the "Original" circular view.

103R (Original & Regional) Mode Screen Control

R ©
Interactive

1
Zoom In Zoom Out \ regional FOV indicators
~

———— Current screen selection

Pan or tilt

Click to bring into
center of view

In a Regional view displaying 100% of video feed (via the Resize buttons - see page 32), your
mouse wheel can be used to scroll the view window vertically before you click on a live image.
After you click on the live image, the mouse wheel becomes the zoom in/out tool.




4R (Four Regional) Display mode:

The view control and look and feel are identical to that as described in the 1O3R mode except the absence of
the Original circular view.

4R PRO (Four Regional Proactive) Display mode:
The 4R PRO mode is similar to the 4R mode except that the quad view windows consecutively rotate in correspondence to

the change of view area in one window. Note that zoom in/out and panttilt control in camera control area is not available in this
mode.

108R (One Original and Eight Regional) Display mode:
The view control and look and feel are identical to that as described in the 103R mode.

Note that if you change the position of a view in hemisphere, e.g., #3 window, you may lose the configuration change by
switching to another display mode. The live view window does not automatically save your view section layout.




Video Stream: This Network Camera supports multiple streams (stream #1 ~ #3) simultaneously. You
can select any one of them for live viewing. For more information about multiple streams, please refer to
page 88 for detailed information.

Manual Trigger: Click to manually enable or disable an event trigger. Please configure an event setting
before enabling this function. A total of 3 or 4 event settings can be configured. For more information
about event setting, please refer to page 95. If you want to hide this item on the homepage, please go
to the System > Homepage Layout > General settings > Customized button to deselect the “show
manual trigger button” checkbox.

Digital Output: Click to turn the digital output device on or off.

PTZ Control Panel: Up
| Return to Home Position
Left = —— Right
Down
Zoom Out Zoom In

Start to Auto Pano

Stop Auto Pano
Pano.: Click this button to start the automated circular rotation through a regional view (360° continuous
rotation). Note that this function does not apply in a Panoramic view because a Panoramic view already
shows the full coverage.
Stop: Click this button to stop the Auto Pano and Auto Rotate functions.

Pan /Tilt /Zoom /Panoramic/Rotate speed: Adjust the speed of these controls when exerted:

-5 -5 -5 - Slower
-4 -4 -4 -
-3 -3 -3 -
-2 -2 -2 -
-1 -1 -1 -
0 0 0 -
1 1 1 1
2 2 2 2
3 8 3 3
4 4 4 4
5 5 5 5 Faster

Note: All regional display positions and PTZ setup are not store on Home screen, and reset after change
of “Display mode” and “Mount type”.

Configuration Area
Client Settings: Click this button to access the client setting page. For more information, please refer to
Client Settings on page 35.

Configuration: Click this button to access more of the configuration options provided with the Network
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Camera. It is suggested that a password is applied to the Network Camera so that only the administrator
can configure the Network Camera. For more information, please refer to the description for the
Configuration menus on page 37.

Hide Button
You can click the hide button to hide the control panel or display the control panel.

Resize Buttons

B Aurbe) B 1004 EH 50% [ B 25% | |

Click the Auto button, the video cell will resize automatically to fit the monitor.
Click 100% is to display the original homepage size.

Click 50% is to resize the homepage to 50% of its original size.

Click 25% is to resize the homepage to 25% of its original size.

Live Video Window
m The following window is displayed when the video mode is set to H.264 / MPEG-4:

H.264 Protocol and Media Options

Video Tt —( ) W EREEEy—Tire
Title and Time

Video Title: The video title can be configured. For more information, please refer to Video settings on
page 76.

H.264 /| MPEG-4 Protocol and Media Options: The transmission protocol (TCP or UDP, etc.)and media
options for H.264 / MPEG-4 video streaming. For further configuration, please refer to Client Settings on
page 35.

Time: Display the current time. For further configuration, please refer to Audio and Video > Image >
General settings on page 76.

Title and Time: The video title and time can be stamped on the streaming video. For further configuration,
please refer to Audio and Video > Image > General settings on page 76.

Video and Audio Control Buttons: Depending on the Network Camera model and Network Camera
configuration, some buttons may not be available.




E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

@ Pause: Pause the transmission of the streaming media. The button becomes the IT Resume button
after clicking the Pause button.

F Stop: Stop the transmission of the streaming media. Click the F Resume button to continue
transmission.

F Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the E Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving

Options on page 36 for details.

Volume: When the l'i_) Mute function is not activated, move the slider bar to adjust the volume on the
local computer.

]"_) Mute: Turn off the volume on the local computer. The button becomes the | Audio On button after
clicking the Mute button.

W Talk: Click this button to talk to people around the Network Camera. Audio will project from
the external speaker connected to the Network Camera. Click this button m again to end talking
transmission.

Mic Volume: When the W Mute function is not activated, move the slider bar to adjust the
microphone volume on the local computer. Note that inernal microphone is mounted on the dome cover.

@ Mute: Turn off the Mic volume on the local computer. The button becomes the Mic On button
after clicking the Mute button.

@ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.




m The following window is displayed when the video mode is set to MJPEG:

Video Title Video|(HTTP-V) Time
Title and Time Video 17:08:56 2011/03/10

Video Control Buttons
| o]l |

Video Title: The video title can be configured. For more information, please refer to Audio and Video >
Image on page 76.

Time: Display the current time. For more information, please refer to Audio and Video > Image on page
76.

Title and Time: Video title and time can be stamped on the streaming video. For more information, please
refer to Audio and Video > Image on page 76.

Video Control Buttons: Depending on the camera model and your current configuration, some buttons
may not be available.

E Snapshot: Click this button to capture and save still images. The captured images will be displayed
in a pop-up window. Right-click the image and choose Save Picture As to save it in JPEG (*.jpg) or BMP
(*.bmp) format.

F Start MP4 Recording: Click this button to record video clips in MP4 file format to your computer.

Press the Stop MP4 Recording button to end recording. When you exit the web browser, video
recording stops accordingly. To specify the storage destination and file name, please refer to MP4 Saving
Options on page 36 for details.

@ Full Screen: Click this button to switch to full screen mode. Press the “Esc” key to switch back to normal
mode.




Client Settings

This chapter explains how to select the stream transmission mode and saving options on the
local computer. When completed with the settings on this page, click Save on the page bottom
to enable the settings.

H.264 | MPEG-4 Media Options
H.264/MPEG-4 Media Options

@ video and Audio
O video Only
O Audio Only

Select to stream video or audio data or both. This is enabled only when the video mode is set to H.264 or
MPEG-4..

H.264 /| MPEG-4 Protocol Options

H.264/MPEG-4 Protocol Options

() UDP Unicast
) UDP Multicast
@TCP

OHTTP

Depending on your network environment, there are four options with the transmission protocols with
H.264 or MPEG-4 streaming:

UDP unicast: This protocol allows for more real-time audio and video streams. However, network
packets may be lost due to network burst traffic and images may be broken. Activate UDP connection
when occasions require time-sensitive responses and the video quality is less important. Note that each
unicast client connecting to the server takes up additional bandwidth and the Network Camera allows up
to ten simultaneous accesses.

UDP multicast: This protocol allows multicast-enabled routers to forward network packets to all clients
requesting streaming media. This helps to reduce the network transmission load of the Network Camera
while serving multiple clients at the same time. Note that to utilize this feature, the Network Camera must
be configured to enable multicast streaming at the same time. For more information, please refer to
RTSP Streaming on page 69.

TCP: This protocol guarantees the complete delivery of streaming data and thus provides better video
quality. The downside of this protocol is that its real-time effect is not as good as that of using the UDP
protocol.

HTTP: This protocol allows the same quality as TCP protocol without needing to open specific ports for
streaming under some network environments. Users behind a firewall can utilize this protocol to allow
camera’s streaming data to pass through.

Two way audio
The half and Full-duplex modes determine the operation mode between the camera and the operator. In
Full-duplex mode, the client PC must have an audio codec capable of full-duplex functionality.

Two way audio




MP4 Saving Options
IMP4 Saving Options

Folder: | c\Record

File name prefix: | CLIP

Add date and time suffix to file name

Users can record live video as they are watching it by clicking B Start MP4 Recording on the main
page. Here, you can specify the storage destination and file name.

Folder: Specify a storage destination for the recorded video files.

File name prefix: Enter the text that will be appended to the front of the video file name.

Add date and time suffix to the file name: Select this option to append the date and time to the end of the
file name. p N

CLIP_20100115-180853

t4

File name prefix Date and time suffix
The formatis: YYYYMMDD_HHMMSS

Local Streaming Buffer Time

Due to unsteady bandwidth flow, live streaming may lag. If you enable this option, the live streaming will
be cached on the camera’s buffer memory before being played on the live viewing window. This helps
produce smoother live streaming. If you enter a value of 3000 milliseconds, the streaming will delay for 3
seconds.




Configuration

Click Configuration on the main page to enter the camera setting pages. Note that only
Administrators can access the configuration page.

TOSHIBA offers an easy-to-use user interface that helps you set up your network camera with
minimal effort. To simplify the setting procedure, two types of user interfaces are available:
Advanced Mode for professional users and Basic Mode for entry-level users. Some advanced
functions (PTZ/ Event/ Recording/ Local storage) are not displayed in Basic Mode.

If you want to set up advanced functions, please click on [Advanced Mode] at the bottom of the
configuration list to switch to Advanced Mode.

In order to simplify the user interface, detailed information will be hidden unless you click on the
function item. When you click on the first sub-item, the detailed information for the first sub-item
will be displayed; when you click on the second sub-item, the detailed information for the second
sub-item will be displayed and that of the first sub-item will be hidden.

The following is the interface of the Basic Mode and the Advanced Mode:

Basic Mode
f 1 Navigation Area
Panoramic camera
Configuration List
[ ] Click to switch to Advanced Mode

:7 Firmware Version




Advanced Mode

L )

{ Navigation Area

Panoramic camera

——_Configuration List

:]7 Click to switch to Basic Mode

:]7 Firmware Version

Each function on the configuration list will be explained in the following sections. Those functions that are

displayed only in Advanced Mode are marked with | Advanced Mode|. If you want to set up advanced
functions, please click on [Advanced Mode] at the bottom of the configuration list.

The Navigation Area provides access to all different views from the Home page (for live viewing) and
Configuration page.

System > General settings

This section explains how to configure the basic settings for the Network Camera, such as the
host name and system time. It is composed of the following two columns: System and System
Time.

System
Host name: Enter a desired name for the Network Camera. The name will be displayed at the top center

of the main page.
Turn off the LED indicator : To disable the status LED light, uncheck this option.




System time

Keep current date and time: Select this option to preserve the current date and time of the Network
Camera. The Network Camera’s internal real-time clock maintains the date and time even when the
power of the system is turned off.

Synchronize with computer time: Select this option to synchronize the date and time of the Network
Camera with the local computer. The read-only date and time of the PC is displayed as updated.

Manual: The administrator can enter the date and time manually. Note that the date and time format are
[yyyy/mm/dd] and [hh:mm:ss].

Automatic: The Network Time Protocol is a protocol which synchronizes computer clocks by periodically
querying an NTP Server.

NTP server: Assign the IP address or domain name of the time-server. Leaving the text box blank
connects the Network Camera to the default time servers.

Update interval: Select to update the time using the NTP server on an hourly, daily, weekly, or monthly
basis.

Time zone |Advanced Mode|: select the appropriate time zone from the list. If you want to upload
Daylight Savings Time rules, please refer to System > Maintenance > Import/ Export files on page 46
for details.

When finished with the settings on this page, click Save at the bottom of the page to enable the settings.




System > Homepage layout |Advanced Mode|

This section explains how to set up your own customized homepage layout.

General settings

This column shows the settings of your hompage layout. You can manually select the background and
font colors in Theme Options (the second tab on this page). The settings will be displayed automatically
in this Preview field. The following shows the homepage using the default settings:

Logo graph
Here you can change the logo at the top of your homepage.

Follow the steps below to upload a new logo:

1. Click Custom and the Browse field will appear.

2. Select a logo from your files.

3. Click Upload to replace the existing logo with a new one.
4. Enter a website link if necessary.

5. Click Save to enable the settings.

Customized button
If you want to hide manual trigger buttons on the homepage, please uncheck this item. This item is
checked by default.

Customized button
Show manual trigger button

Save




Theme Options

Here you can change the color of your homepage layout. There are three types of preset patterns for you

to choose from. The new layout will simultaneously appear in the Preview filed. Click Save to enable the
settings.

Font Color of the
Video Title

Font Color

Background Color of the
Control Area

Background Color of

Font Color of the the Video Area
Configuration Area F Col
rame Color
Background Color of the

Configuration Area

Preset patterns




m Follow the steps below to set up a custom homepage:
1. Click Custom on the left column.
2. Click to select a color on on the right column.

Themes Color
Font color:
i Font color of configuration area: #FFFFFF
_— Color Selector

Font color of video title:
Bk color of control area:
Bk color of configuration area:

| | - Bk color of video area:

Custom ° Frame color:

Pattern

Custom

3. The palette window will pop up as shown below.

o

4. Drag the slider bar and click on the left square to select a desired color.
5. The selected color will be displayed in the corresponding fields and in the Preview column.
6. Click Save to enable the settings.




System > Logs | Advanced Mode |

This section explains how to configure the Network Camera to backup the system log to a
remote server.

Log server settings

Log server settings
Enable remote log
IP address:

port: 514

Save

Follow the steps below to set up the remote log:

1. Select Enable remote log.

2. In the IP address text box, enter the IP address of the remote server.
2. In the port text box, enter the port number of the remote server.

3. When completed, click Save to enable the setting.

You can configure the Network Camera to send the system log file to a remote server as a log message.

When using this feature, the appropriate syslog server is required for receiving the system log message
from the Network Camera.

System log

This column displays the system log in chronological order. The system log is stored in the Network
Camera’s buffer and dated events will be overwritten when the number of events reaches a limit.

The system log messages stored in the Network Camera will be all cleared after reboot or power down
the Network Camera.




Access log

Access log displays the access time and IP address of all viewers (including operators and
administrators) in chronological order. The access log is stored in the Network Camera’s buffer and older
events will be overwritten when the number of events reaches a limit.

The access log messages stored in the Network Camera will be all cleared after reboot or power down
the Network Camera.

System > Parameters |Advanced Mode]|

The View Parameters page lists the entire system’s parameters in an alphabetical order. If you
need technical assistance, please provide the information listed on this page.




System > Maintenance

This chapter explains how to restore the Network Camera to factory default, upgrade firmware
version, eftc.

General settings > Upgrade firmware

Firmware file:

This feature allows you to upgrade the firmware of your Network Camera. It takes a few minutes to
complete the process.
Note: Do not power off the Network Camera during the upgrade!

Follow the steps below to upgrade the firmware:

1. Download the latest firmware file from the TOSHIBA website. The file is in .pkg file format.

2. Click Browse... and specify the firmware file.

3. Click Upgrade. The Network Camera starts to upgrade and will reboot automatically when the upgrade
completes.

If the upgrade is successful, you will see “Reboot system now!! This connection will close”. After that, re-
access the Network Camera.

The following message is displayed when the upgrade has succeeded.

Reboot system now!!
This connection will close.

The following message is displayed when you have selected an incorrect firmware file.

4 1\
Starting firmware upgrade...
Do not power down the server during the upgrade.
The server will restart automatically after the upgrade is
completed.
This will take about 1 - 5 minutes.
Invalid firmware version
Unpack fail...system is rebooting...

(N J

General settings > Reboot

This feature allows you to reboot the Network Camera, which takes about one minute to complete. When
completed, the live video page will be displayed in your browser. The following message will be displayed
during the reboot process.

The device is rebooting now. Your browser will reconnect to hitp:/192.168.5.151:80/
[fthe connection fails, please manually enter the above IP address in your browser.

If the connection fails after rebooting, manually enter the IP address of the Network Camera in the
address field to resume the connection.




General settings > Restore

This feature allows you to restore the Network Camera to factory default settings.

Network: Select this option to retain the Network Type settings (please refer to Network Type on page
60).

Daylight Saving Time: Select this option to retain the Daylight Saving Time settings (please refer to
Import/Export files below on this page).

If none of the options is selected, all settings will be restored to factory default. The following message is
displayed during the restoring process.

The device is rebooting now. Your browser will reconnect to hitp:/192.168.5.151:80/
[fthe connection fails, please manually enter the above IP address in your browser.

Import/Export files |Advanced Mode |

This feature allows you to Export / Update daylight saving time rules, custom language file, and
configuration file.

General settings || Import/Export files
Export files
Export daylight saving time configuration file
Export
Export configuration file
Export
Export server status report
Export
Upload files
Update daylight saving time rules: | |[ Browse.. || Upload
Upload configuration file: | |[ Browse.. || Upload

Export daylight saving time configuration file: Click to set the start and end time of DST.

Follow the steps below to export:

1. In the Export files column, click Export to export the daylight saving time configuration file from the
Network Camera.

2. A file download dialog will pop up as shown below. Click Open to review the XML file or click Save to
store the file for editing.




File Download

X]

Do you want to open or zave this file?

Mame: config_dst.xml
Type: ¥ML Docurment, 11.1 KB
From: 192.168.5.151

(L4

Open l[ Save ll Cancel ]

W'hile filez from the Internet can be useful, zome files can potentially
harm your cormputer. 1F pou do not trugt the zource, do not open o
zave this file, What's the nsk?

3. Open the file with text editor and locate your time zone; set the start and end time of DST. When
completed, save the file.

In the example below, DST begins each year at 2:00 a.m. on the second Sunday in March and ends at
2:00 a.m. on the first Sunday in November.

Update daylight saving time rules: Click Browse... and specify the XML file to update.

If incorrect date and time are assigned, you will see the following warning message when uploading the
file to the Network Camera.




The following message is displayed when attempting to upload an incorrect file format.

Export configuration file: Click to export all parameters for the device and user-defined scripts.

Update configuration file: Click Browse... to update a configuration file. Please note that the model and
firmware version of the device should be the same as the configuration file. If you have set up a fixed IP
or other special settings for your device, it is not suggested to update a configuration file.

Export server staus report: Click to export the current server status report, such as time, logs,
parameters, process status, memory status, file system status, network status, kernel message..., and so
on.




Security > User Account

This section explains how to enable password protection and create multiple accounts.
Root Password

The administrator account name is “root”, which is permanent and can not be deleted. If you want to add

more accounts in the Manage User column, please apply the password for the “root” account first.

1. Type the password identically in both text boxes, then click Save to enable password protection.

2. A window will prompt for authentication; type the correct user’s name and password in their respective
fields to access the Network Camera.

Note:
* Leaving the root password field empty means the camera will not be protected by password.

Privilege management |Advanced Mode]

Digital Output & PTZ control: You can modify the management privilege as operators or viewers. Select
or de-select the checkboxes, and then click Save to enable the settings. If you give Viewers the privilege,
Operators will also have the ability to control the Network Camera through the main page. (Please refer
to Configuration on page 31).

Allow anonymous viewing: If you check this item, 3GPP clients can access the live stream without
entering a User ID and Password.

Note:
* Select RTSP Streaming Authentication to disable.
* This function will not work with Internet Explorer.

Account management

Administrators can create up to 20 user accounts.
1. Input the new user’s name and password.
2. Select the privilege level for the new user account. Click Add to enable the setting.

Access rights are sorted by user privilege (Administrator, Operator, and Viewer). Only administrators can
access the Configuration page. Though operators cannot access the Configuration page, they can use
the URL Commands to get and set the value of parameters. For more information, please refer to URL
Command Guide. Viewers access only the main page for live viewing.

Here you also can change a user’s access rights or delete user accounts.
1. Select an existing account to modify.
2. Make necessary changes and click Update or Delete to enable the setting.




Security > HTTPS (Hypertext Transfer Protocol over SSL)

| Advanced Mode |

This section explains how to enable authentication and encrypted communication over SSL
(Secure Socket Layer). It helps protect streaming data transmission over the Internet on higher
security level.

Create and Install Certificate Method

Before using HTTPS for communication with the Network Camera, a Certificate must be created first.
There are two ways to create and install a certificate:

Create self-signed certificate

1.Select this option from a pull-down menu.

2. In the first column, select Enable HTTPS secure connection, then select a connection option: “HTTP
& HTTPS” or “HTTPS only”.

3.Click Create certificate to generate a certificate.

4. The Certificate Information will automatically be displayed as shown below. You can click Certificate
properties to view detailed information about the certificate.




5. Click Home to return to the main page. Change the address from “http://” to “https://“ in the address
bar and press Enter on your keyboard. Some Security Alert dialogs will pop up. Click OK or Yes to
enable HTTPS.

https://

https://1192.168.5.151/index.html

Security Alert E'
rl_o ‘Y'ou are about to view pages aver a secure connechion.
i
Ay information you exchange with this site cannot be
viewed by anyone elze on the ‘Web.
[ I thie Future, do et sha this warking
[ Ok ] [ Mare Info ]
Security Alert PX| Security Information | X |
rir‘"l Infarmation you exchangs with this s_ite cannot be yiewed ar rii“ Thiz page contains both secure and nonsecune
?. changed by others. However, there is a problem with the site's ?. items.

security certificate,

Do pou want to dizplay the nonsecure items?

& The zecurity certificate was izsusd by a company you have
nat chozen bo trust. Yiew the certifizate to determing whether
ou wank bo trugt the certifving authority, I

Tes H Mo ] [ tare Info

a The zecurty certificate date iz walid.

The narme on the security certificats is invalid or dogs not
match the name of the site

Do pou want to proceed?

Tes ] I &[] ] [\-"iew Certific:ate




Create certificate request and install : Select this option if you want to create a certificate from a
certificate authority.

1. Select this option from a method pull-down menu.
2. Click Create certificate to generate the certificate.




3. If you see the following Information bar, click OK and click on the Information bar at the top of the page
to allow pop-ups.

&

4. The pop-up window shows an example of a certificate request.

5. Look for a trusted certificate authority that issues digital certificates. Enroll the Network Camera.
Wait for the certificate authority to issue a SSL certificate; click Browse... to search for the issued
certificate, then click Upload in the column.




ANOTE _

e 1. How do | cancel the HTTPS settings?
1-1. Click on the Remove certificate button.

1-2. The webpage will redirect to a non-HTTPS page automatically.
e 2. If you want to create and install other certificates, please remove the existing one.

Enable HTTPS
Check this item to enable HTTPS communication, then select a connection option: "HTTP &
HTTPS” or “HTTPS only”. Note that you have to create and install a certificate first before

clicking the Save button.




Security > Access List

This section explains how to control access permission by verifying the client PC’s IP address.

General Settings

General settings

Maximum number of concurrent streaming: | 40 E| [ Connection management ]

Maximum number of concurrent streaming: Simultaneous live viewing for 1~10 clients (including stream
1 to stream 3). The default value is 10. If you modify the value and click Save, all current connections will
be disconnected and automatically attempt to re-link.

Connection management: Click this button to display the connection status window showing a list of the
current connections. For example:

IP address Elapsed time User ID
Il 172.16.2.483 00:00:05

- 192.168.4.104 01:49:35

Refresh Add to deny list Disconnect Close

Note that only consoles that are currently displaying live streaming will be listed in the Connection
management list.

m |P address: Current connections to the Network Camera.
m Elapsed time: How much time the client has been at the webpage.

m User ID: If the administrator has set a password for the webpage, the clients have to enter a user name
and password to access the live video. The user name will be displayed in the User ID column. If the
administrator allows clients to link to the webpage without a user name and password, the User ID
column will be empty.

There are some situations that allow clients access to the live video without a user name and

password:

1. The administrator does not set up a root password. For more information about how to set up a root
password and manage user accounts, please refer to Security > User account on page 49.

2. The administrator has set up a root password, but set RTSP Authentication to “disable“. For more
information about RTSP Authentication, please refer to RTSP Streaming on page 69.

3. The administrator has set up a root password, but allows anonymous viewing. For more information
about Allow Anonymous Viewing, please refer to page 49.




m Refresh: Click this button to refresh all current connections.

m Add to deny list: You can select entries from the Connection Status list and add them to the Deny List
to deny access. Please note that those checked connections will only be disconnected temporarily
and will au